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Topic 12 ELECTRONIC PUBLICATION 

 Recommended Coverage Duration: 32 periods (5 1/3 weeks) 
Guidance to the Teacher 

• For each of the items to be developed in this topic, let the learners develop, make a 
presentation of their designed item for the rest of the class to comment and make 
improvements in the item. Where possible, get a third party to determine what they need 
in order to advertise a product. 

• Discourage the learners from using inbuilt templates while designing each of the items.  
• Train learners how to adjust the units of measurement from inches, to pixels and to 

centimetres for learners to develop this competence.  
• You are advised to organise the teaching in form of a project to allow the learner 

develop specific skills at a time.  
• As much as possible demonstrate to learners and allow them time to develop the skills 

of their own through the project work. 
Suggested Competences for Assessment 

• Assess the learners’ ability to create and design an electronic publication in form of a 
flyer or banner to a level of advertising an item. 

Background 
Electronic publishing has a history of being used to describe the development of new forms of 
production, distribution, and user interaction in regard to computer-based production of text and 
other interactive media. 
Electronic publishing enables professional designers to create sophisticated documents that 
contain text graphics and many colours. It is ideal for the production of high quality colour 
documents such as textbooks, corporate newsletters, marketing literature (adverts), product 
catalogues and annual reports, and being able to share them over the Internet. 
Learning Outcome: The learner should be able to design a brochure, business card, flyer or 
banner for a given function. 
 

12.1 Introduction to Electronic Publishing 

Sub topic Objectives: 
1. Meaning of electronic publishing  
2. Examples of electronic publishing software  
3. Features of electronic publishing software  
4. Application areas, uses for electronic publishing 

12.1.1 Meaning of electronic publishing  
In this chapter, electronic publishing is used to mean ‘desktop publishing’ which refers to laying 
out text, graphics and pictures in order to produce a professional-looking print publication. 
Desktop Publishing (DTP) Software applications provide special tools for fine-tuning the 
appearance of text and graphics in a document.  
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12.1.2 Examples of electronic publishing software  

 
Figure 1 Scribus, an open source desktop publishing application. 
The following is a list of major desktop publishing software. A wide range of related software tools 
exist in this field, including many plug-ins and tools related to the applications listed below. 

 Microsoft Publisher  
 Adobe Page Maker 
 QuarkXPress 
 Adobe InDesign 
 Coreldraw 
 Studio Publisher 
 Scribus 

Online Desktop Publishing Software 
 Canva 
 Fatpaint 
 Lucidpress - Desktop publishing and page layout software that is collaborative 

12.1.3 Features of electronic publishing software  
Desktop Publishing and Word Processing have many similar features, and it may not be obvious 
which you should use to produce a document. The similarities are: 

 Both deal with text, which can be formatted (font, size, colour, bold, italic, etc.) 
 Both can contain pictures and tables 
 Microsoft Word and Publisher have similar features, such as, WordArt, colour schemes, 

text boxes, etc. 
  

http://en.wikipedia.org/wiki/QuarkXPress
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Qn: List the key differences between word processing and desktop publishing. 
Word Processor Desktop Publishing 
1. Word Processing programs are designed 

to focus on text. 
1. Designed to focus more on the structure 

or display of a document. 
2. WPs are generally more condensed than 

DTPs and so are better suited for 
transferals across the internet. 

2. Large size and more complicated file 
formats, users usually convert them to 
portable document format (.pub) before 
transmission. 

3. WPs only allow the simplest edits to 
graphic such as changing of its size inside 
a document. 

3. DTP programs give the user the tools 
required to greatly edit a piece of graphic 

4. Contain a few simple templates for letters, 
memos, resumes, and reports. 

4. Contain lots of advanced templates for 
brochures, business cards, certificates, 
calendars, newsletters, etc. 

5. Many people have word processing skills 
because it is easier to learn, and so typists 
who only do word processing get lesser 
business jobs today. 

5. People who know desktop publishing 
typically get much larger business jobs 
than people who only do word processing.  
 

6. All designing is user created and this 
wastes time. For example: Formatting a 
newsletter in a word processor may take 
several hours for every issue while 
formatting a newsletter in a professional 
publishing program will take several hours 
the first time and only a fraction of the 
time for subsequent issues. 

6. Desktop publishing uses software to aid 
designing and increase the amount of 
functions and increase the speed and 
transfer abilities in the document. 

12.1.4 Application areas, uses for electronic publishing 
Desktop publishing software can be used in a number of areas, for example, Microsoft Publisher 
can be used for creating Advertisements, Award Certificates, Banners, Brochures, Business 
Cards, Business Forms, Calendars, Catalogs, Envelopes, Flyers, Gift Certificates, Greeting Cards, 
Invitation Cards, Labels, Letterhead, Menus, Newsletters, Paper Folding Projects, Postcards, 
Resumes, and Signs. 

12.2 Publishing Basics 

Sub topic Objectives: 
1. Creating and saving new documents.  
2. Adjusting measurement units (inches, pixels, points, and centimetres). 
3. Saving a new document 
4. Typesetting text 

Some Useful Definitions:   
Frame – Most publications are divided into several different areas called frames.   
A frame can contain a variety of objects such as graphics, tables, or text boxes.  Frames can be 
resized, moved and manipulated to suit your needs.   
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Handles – When you click on a frame, small circles appear around the edge of the frame.  
These are called handles.  You can click and drag on the handles to resize your frame.  

 
Template ‐ A Template is a tool used in Publisher to help you easily create basic 
publications.  The template has a set of pre‐chosen design styles that you can use 
as it is or customize as you see fit.   

 Opening Publisher  
To Open Publisher either:  

 Double click on the Microsoft Publisher Icon on your desktop, OR  
 Click on Start in the lower left hand corner of your desktop, move up to Programs, and 

then click on Microsoft Publisher. 
Creating New Publications with Publisher design templates.  

 When you first open Publisher, Publisher offers you a number of different publication 
types to start with.  

 Click on one of the publication types in the main window or in the list on the left side 
of the main window to view a list of templates that will walk you through the process 
of making basic design choices for your publication. These choices include color 
schemes, font styles, and more.  

Text Boxes  
 To Insert a Text Box: Click the Text Box button on the Objects toolbar. Position the 

mouse pointer where you would like to insert the text box and click and drag until the text 
box reaches the desired size. Release the mouse button when you’re finished and enter 
the text.  

 To Format a Text Box: Right-click the text box you want to format and select Format 
Text Box from the shortcut menu. Make your selections in the Format Text Box dialog 
box and click OK when you’re finished.  

 To Link Text Boxes: Click the overflowing text box (marked with an overflow indicator) to 
select it. Click the Create Text Box Link button on the Connect Text Boxes toolbar. Click 
inside an empty text box with the pointer.  

 To Unlink Text Boxes: Select the linked text box that comes before the text box(es) you 
want to unlink, and click the Break Forward Link button on the Connect Text Boxes 
toolbar.  

  

Text Frame  
Handles  

Picture Frame  
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 To Move Between Text Boxes: Click the Go to Previous Text Box or Go to Next Text 
Box buttons, or click the Previous Text Box or Next Text Box button on the Connect 
Text Boxes toolbar.  

 To Add Continued Notices: Select Format—>Text Box from the menu and click the Text 
Box tab. Click the Include "Continued on/from page..."check box and click OK.  

 
Formatting Text   

1. Click in a text frame.  
2. Begin typing.  
3. Click and drag over the text you typed to select it for formatting changes.  
4. Use the Formatting Toolbar or click on Format  Font to make changes to the 

publication 

 
Undoing Changes  
Creating a publication often involves trial and error.  Unlike many of Microsoft Office’s other 
applications, in Publisher you cannot preview what a change is going to look like until you 
apply it.    
To undo actions, click on the undo button on the standard toolbar    or click on Undo 
in the Edit Menu.  
Drawing and Graphics  

 To Insert a Clip Art Graphic: Select Insert —> 
Picture —> Clip Art from the menu, locate an 
appropriate graphic, and click the graphic to insert it.   

 To Insert a Picture: Select Insert —> Picture —> 
From File from the menu, select the file location and 
name, and click Insert.   

 To Adjust Text Wrapping: Double-click the object, 
click the Layout tab, select a text wrapping option, 
and click OK.  

 To Draw an Object: Click the appropriate button 
(Line, Arrow, Oval, Rectangle, or AutoShapes) on 
the Objects toolbar, click where you want to draw the object, and drag until the object 
reaches the desired size. Hold down the <Shift> key while you drag to draw a perfectly 
proportioned shape or straight line.  

 To Move an Object: Click the object and drag it to a new location. Release the mouse 
button when you’re finished.  

 To Resize an Object: Click the object to select it, click and drag one of its sizing handles 
and release the mouse button when the object reaches the desired size. Hold down the 
<Shift> key while dragging to maintain the object’s proportions while resizing it.  
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 To Delete an Object: Select the object and press the <Delete> key.  
 To Format an Object: Double-click the object.  
 To Insert a WordArt Object: Select Insert —> Picture —> WordArt from the menu, select 

a design from the WordArt Gallery dialog box, and click OK. Enter the text you want 
WordArt to format and adjust the font type and size, if necessary. Click OK.  

 To Group Objects: Select the objects you want to group and click the Group Objects 
button.  

 To Rotate an Object: Select the object and click and drag its rotation handle. Release the 
mouse button when you’re finished rotating.  

 
Saving Your Publication  
There are two basic ways to save your publication  

Point and click on the save icon    on your toolbar, OR     
1. Click on the File Menu and Save As.  
2. When the Save As Dialogue Box appears Click Browse and find the location on 

your computer where you would like the file saved.   
3. Type the name of your publication in the File Name field.   
4. Click on the Save button  

Printing Your Publication  

There are two basic ways to print your publication: Click on the print icon on your toolbar    
.  This will print one copy of your publication with the default print options.  ‐OR  

1. Click on the File Menu and click Print.  
2. When the print window appears, select the desired number of copies and choose 

any other printing options you want.  
3. Click OK.  

Search Box  

Search Limiter  

Drop down  
menu options  
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12.3 Document Enhancement and Layout 

Sub topic Objectives: 
Document Enhancement: 

1. Object properties: changing background colour. 
2. inserting text boxes. 
3. inserting graphics. 
4. inserting page borders. 
5. Formatting text. 
6. Importing  text. 
7. Adding page numbers. 
8. checking spelling. 
9. changing spacing. 

Document layout: 
10. Aligning a document 
11. Organizing text along objects.  
12. customizing page size. 

Creating a Calendar  
To Create a Calendar:   
1. Open Microsoft Publisher by double clicking the icon on the desktop or finding it under 

the start menu.   
2. Click on Calendars from the main window or the list on the left. A selection of 

predesigned templates appears for you to choose from.   
3. Click on one of the pre‐designed templates that you like. It will appear at the top of the 

area on the right side of the page.  
4. You can either stick with the default design choices that are part of the template, or you 

can customize them by clicking the downward pointing arrow to the right of a design 
section and choosing any of the options provided by clicking on it.     

5. Click on the Set Calendar Dates button and choose the period of time that you would 
like your calendar to cover.  

6. Click on Create at the bottom to create your calendar.  
Now that you have made your basic calendar selections, it is time to further customize the 
publication.  
Creating a Business Card  

1. Open Microsoft Publisher by double clicking the icon on the desktop or finding it 
under the start menu.  

2. Click on Publications for Print then Business Cards, and finally Accent Box 
Business Card.  
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3. In the personal information form that opens, enter your 
own contact information and click on OK.  (If you 
accidentally close your personal information and you 
want to edit it further, click on the Edit Menu and 
Personal Information to retrieve the form.)  

4. In the task 
pane on the left 
side of the window, you are given 
different options you can adjust.  As you 
click on the different steps at the top 
of the task pane, the options 
change on the lower part of the task 
pane.  

5. Click on Business Card Options.  
a. Choose to Include a logo.  
b. Choose the traditional Landscape orientation  
c. Choose to have Multiple copies per sheet  

6. Click on Publication Designs.  
a. Leave the selected Accent Box.  
b. Click on Color Schemes and select the desired color scheme.  

7. Click on Font Schemes and select the desired font scheme.   
Now that you have completed the Business Card Wizard, you can customize the business 
card.  Change the format or insert additional clip art, if you wish.    
  
To adjust the logo,   
• Double click on the picture portion and use the clip art gallery to find a different picture.  
• Click in the text portion and type your organization’s name.  
 Creating a Personalized Greeting Card  

1. Open Publisher by double clicking the icon on the desktop or finding it under the start 
menu.  

2. Click on Publications for Print  Greeting Cards  Birthday  Birthday Card 72  
3. Click on Greeting Card Options  

a. Select Greetings Bar.  
b. Select Full Verse  
c. Click on Select a suggested verse.  A 

dialog box will open click on a verse on 
the left side and on the right side it will 
show you the front message and the 
inside message.  Select the verse you 
would like to use and click on OK.  

  4. Click on Page Options  
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a. Choose the Quarter page side fold 
option.  

6. Click on Card Gallery  
a. Leave Birthday 72 selected.  

7. Click on Color Schemes  
a. Select the desired color scheme.  

8. Click on Font Schemes  
a. Select the desired font scheme.  

 Now that you have completed the Greeting Card 
Wizard, you can customize the greeting card.    
At the bottom of the screen are sheets with numbers 
on them (1, 2, 3, 4).  Click on 1 to see the front of 
the card.  Click on 2 or 3 to see the inside of the card.  Click on 4 to see the back of the 
card.  

12.4 Publication projects for class presentation 

This topic is best learnt through project based exercises. Students should practice by doing lots of 
exercises. Below are some exercises that can be done and presented in class. 
Exercise 1 
Using a suitable publishing software, design eight identical business cards tiled on A4 page size, 
3.5” wide and 2” height         

(a) the cards’ layout and spacing is as follows; 
i) left and right margin should be 0.5”. 
ii) top and bottom margins 0.7. 
iii) the vertical and horizontal gap between cards 0.6. 

(b) the details of the card are: 
i) A logo of the company at the left hand side of the card. Provide the logo. 
ii) a company name of your choice. 
iii) Job title. E.g. Managing Director. 
iv) your name e.g. Aisha Kainembabazi. 
v) contact address, phone and e-mail. 

(c) include crop marks around each card 
(d) Save the publication as “my business card’ and print your work. 

Exercise 2 
Using a desktop publishing application of your choice, you are required to design a flier about the 
annual MTN marathon. This year’s marathon is dubbed, “Run for water”, and its proceeds will be 
used to install piped water in rural hospitals. The marathon will take place on 30 th December. The 
following are the specifications of the flier: 

a) Flier size 10cm x 28 cm, paper size A4. 
b) Should print two fliers per paper, with a horizontal gap of 0.5cm. 
c) A top margin of 0.9cm and a side margin of 0.25cm. 
d) Add a simple and suitable design layout. 
e) Design and Insert the MTN logo. 
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f) Use text boxes to add the details such as the Title, Theme, Entry fees, Date, Starting 
location, End location, Telephone Contact of organizer and email. T shirts will be 
provided to all participants. NB: Invent the above details where not provided. 

g) Use at most three colors in your publication. 
h) Add your name as header and print your work. 
i) Save your work as Water Marathon. 

Exercise 3 
You have just got a job that you are going to do during your holidays. Your uncle in the village 
has established a dairy farm in the village and he is going to be supplying you with milk so that 
you can sell it in the township. However, your notice that there are many competitors doing the 
same business. 
(a). Suggest a suitable name for your business and design an advert for your business. 
(b). Adjust the page size to a width of 400 pixels and a height of 200 pixels.  
(c). Insert a relevant clip art near the left bottom corner of the advert. (02 mks) 
(d). Include details such as the location of your business, price per liter and any special offer or 
discounts offered. 
(e). Use auto shapes to create a logo to make your advert professional. Use two colors in your 
logo. 
(f) Add your name and phone number as footer. 
(g) Save your work milk advert. 
(g)Remove any visible crop marks in your print preview and print out four cards duplicated on one 
page. 
Exercise 4 
Use any desktop publishing software to design a certificate of excellence for Kiryamenvu 
Senior Secondary Senior six (S.6) candidates who have excelled in the following application 
packages: Ms word, Ms Excel, Ms Powerpoint, Ms Access and Ms Publisher. Provide space 
for the signatures of the head teacher and the head of ICT department.   (10 mks) 

 (a)  Adjust the paper size to a width of 11 inches and a height of 8.5 inches. 
(b)  Insert a clip art to represent the owner’s photograph.  (02 mks) 
 (c)  Use your name as the owner of the certificate.   (02 mks) 
 (d)  Insert your name and personal number in the footer.     (02 mks) 
 (e)  Save and print your publication.       (02 mks) 

Exercise 5 
Use any desktop publishing software to design a one page calendar for Kampala Sports 

Academy for next year. Use a creative design template for this task.  (5 mks) 
 (a)  Adjust the paper size to a width of 29.7cm and a height of 21 cm.  (2 mks) 
(b)Use a hexagonal auto shape, and a text box to create the logo for 
Kampala Sports Academy (KSA) as shown below and insert it in the top 
right corner of the calendar. Format its outline and text color to blue and 
a yellow fill. (5 mks) 
(b) Insert some relevant clip art and graphics on your calendar. (02 mks) 
 (c)  Add a text box with the slogan, ‘Sports for Life’. 
 (02 mks) 
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 (d)  Insert your name and personal number in the footer.  (02 mks) 
 (e)  Save and print your publication.  (02 mks) 

Exercise 6 
Alpha Restaurant is a newly established restaurant in Mukono. You have been asked to design a 
menu card for the restaurant with the following items. 

No. Item Price 

1 Q Cakes 1500/= 

2 Chappatti 500/= 

3 African Tea 1000/= 

4 All food + Beans 3000/= 

5 All food + Meat 4000/= 

6 All food + fish 5000/= 

7 All food + Chicken 7000/= 

8 Mineral Water 1200/= 

9 Soda 1000/= 

Use a suitable desktop publishing application to: 
(i) Create a card of width side 20cm and height 12.5cm. 
(ii) Apply settings such that two copies of the card are printed per A4 size sheet of paper. 
(iii) Insert the above table and position it on the right of the card. 
(iv) Insert a text box on the left of the card and add the text, "ALPHA RESTAURANT MUKONO". 
(v) Insert a suitable clip art and a word art with the word ‘MENU’. 
(vi) Apply a suitable background color and boarder. 
(vi) Save your work as Mukono Menu and Print out one sheet containing two cards. 
Exercise 7 
It is open day at your school and you have been tasked to design a two page brochure with 

information about the profile your school as follows: 
 (a). The brochure will be printed on two pages each page divided into 3 panels, i.e. a total of 6 

panels (i-vi) as follows: 
 (i) The outer top panel (third column on page 1) will be the title with the name of the school, 

the motto, the logo, the words, ‘SCHOOL PROFILE’.  
 (ii) The second panel (first column on page 2) will have a Main Inside Heading; ‘ABOUT THE 

SCHOOL’. Add the following content to this panel: 
 A clip art to represent the main building at the school. 
 SCHOOL VISION: To be an academic institution where provision of quality education for 

life in a dynamic world guides all activities. 
 SCHOOL MISSION: To equip the youth with relevant knowledge, marketable skills, 

Christian values and right attitudes. 
 CORE VALUES: Love, wholesomeness, timeliness and diligence. 
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 (iii) The third panel (second column on page 2) should have a bulleted list of subjects offered at 
O’ level and A’ level. 

 (iv) The fourth panel (third column on page 2) should have a list of co-curricular activities available 
at the school. Include a few related clip art graphics. 

 (v) The fifth panel (first column on page 1) Should have the school background as follows:  
HISTORY: The school was founded in 1946 as a junior school by the Mill Hill Missionary 

fathers. It became a government aided school and upgraded to secondary status (S.1 to 
S.4) in 1965. In 1981, the school was upgraded again to A’ level status (S.1- S.6) offering 
Arts and Science subjects.  

STAFFING: The school has a total of 57 teaching staff. The staff is very competent and 
committed. 52 teachers have at least a first university degree while 5 have diplomas in 
education; many of them have a teaching experience of above 10 years. The other staff 
are the administrative and support staff. 

 (vi) The sixth panel (second column on page 1) should have the following: 
LOCATION of the school, (e.g. Plot 12, Akira avenue, 2km from Town). 
P. O. Box, 1343, Kampala., Telelphone: 03925637289 and email: eg admin@gmail.com. 
Exercise 8 
You are the chairperson of the either the Christian association or the Islamic association at your 
school, and you are preparing for the handover party in which your cabinet will hand over to the 
new leaders in the 2014/2015 cabinet. However, you notice that you have not yet designed 
certificates for the members in your cabinet. 
(a) Using a desktop publishing program of your choice, create a certificate of service with 
dimensions 28centimenters by 7.874 inches. 
(b) Add suitable text phrases on the certificate describing the name of the association, nature of 
the certificate, name of recipient, year of service, and cabinet post of recipient. 
(c) Use your name and post (chairperson) for the recipient details and add two signatories (the 
patron and the head teacher) at the bottom of the certificate. 
(d) Apply a suitable boarder art around your certificate. 
(e) Use auto shapes to add an appropriate religious symbol of your choice to the center of the 
master background page of your publication.  
(f) Apply a fill color to the autoshape in (e) above and make it faint so that it does not interfere 
with the items in the foreground.  
(g) Save your work as 2013_2014 Certificates and printout a copy of your certificate. 
Exercise 9 



13 
 

You are the graphics designer of Computer Solutions LTD and you have been requested to 
design staff identity cards in the following format: 

 
(a) Set up the card width at 3.4 inches and height at 2.2 inches. 
(b) Set the Side and Top margins at 0.5 inches and all margin guides at 0.1 inches.  
(c) Choose a layout type of Multiple pages per sheet and add a horizontal gap of 0.5 and a 
vertical gap of 1.1 inches. 
(d) Use a table, autoshapes, text boxes, and clip art to create the above card design use at least 
three colors in your design. 
 (e) Duplicate the above card to create 6 more identical cards and customize them with the 
following details: 

Name Designation ID №: 
NAKINGA JESSE DIRECTOR CSU/001 
ABDUL MAJID NUR GENERAL MANAGER CSU/002 
KISAAWE AHMED SYSTEMS ADMINISTRATOR CSU/003 
<<YOUR NAME>> GRAPHICS DESIGNER CSU/004 
MWESIGWA SAMUEL TECHNICIAN CSU/005 
APIO JOAN SECRETARY CSU/006 

 (f) Printout all the 6 cards on one A4 size sheet of paper page. 
(g) Save your work as CSU IDs. 
Exercise 10 
Use any publishing software of your choice, design a greeting card for a couple on their 
anniversary.   

“Happy Anniversary” 
“Happy Anniversary Ahmed and Shakira! We don’t know why two people would get married 
and ruin a perfectly good relationship, but you two have been great examples of why 
marriage is wonderful. . (or) . .You two have been married so long you probably cannot 
remember when you weren’t married!   Congratulations and happy memories. With love, 
“Use your two Names” 

 Use:  
a) Appropriate font styles, graphics and colors. 
b) Insert a border of your choice and print your card.   
c) Save your card as ‘Anniversary card.jpg’ 
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d) Print your work. 
 

NB: For more activities on the support files approach, 
practical questions, lab activities, and over twenty sets of 

standard full past papers and their support files, get a copy 
of the book entitled “COMPUTER PRACTICAL 

APPLICATIONS LAB ACTIVITIES FOR UGANDA” by 
Mukalele Rogers 

 
 
 
 
 
 
 
 

http://books.mukalele.net/
http://books.mukalele.net/
https://www.mukalele.net/

